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Safety information

e If your product is not marked with this symbol @ it must be
connected to an electrical outlet that is properly grounded.
CAUTION: Do not set up this product or make any electrical or
cabling connections, such as the power cord or telephone,
during a lightning storm.

e The power cord must be connected to an electrical outlet that is
near the product and easily accessible.

. Refer service or repairs, other than those described in the
operating instructions, to a professional service person.

* This product is designed, tested, and approved to meet strict
global safety standards with the use of specific Lexmark
components. The safety features of some parts may not always
be obvious. Lexmark is not responsible for the use of other
replacement parts.

*  Your product uses a laser.

CAUTION: Use of controls or adjustments or performance of
procedures other than those specified herein may result in
hazardous radiation exposure.

*  Your product uses a printing process that heats the print media,
and the heat may cause the media to release emissions. You
must understand the section in your operating instructions that
discusses the guidelines for selecting print media to avoid the
possibility of harmful emissions.

Conventions

It may help you to recognize the caution and warning conventions used in
this document.

CAUTION: A caution identifies something that could cause you harm.
Warning: A warning identifies something that could damage your product
hardware or software.

Attention!

This symbol identifies static-sensitive parts. Do not touch
in the areas near these symbols without first touching the
metal frame of the printer.
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Introduction
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Your printer is available in three models:

* Lexmark C510, with 64MB of
standard memory, one 250-sheet
tray, and USB and parallel
connectors.

e Lexmark C510n, which has
128MB of standard memory, as
well as an Ethernet 10BaseT/
100BaseTX print server installed,
with an Ethernet connector.

e Lexmark C510dtn, which has the
same features as the C510n, as
well as a duplex unit and a
530-sheet drawer.

You can purchase several different
options for your printer. Launch the
publications CD and then click User’s
Reference. Look for printer overview
information.



Other sources of information

Publications CD

Information pages

e Help Guide
* Printing Guide
e Jam Clearance

Introduction
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If you need more information after you
have completed setup, refer to the other
printer documentation.

The publications CD provides
information about loading media,
clearing error messages, ordering and
replacing supplies, and troubleshooting.
It also provides general information for
administrators.

The information on the publications CD is
also available on our Lexmark Web site at
www.lexmark.com/publications.

Information pages are stored inside the
printer. They provide information about
loading print media, diagnosing and
solving print problems, and clearing jams
from the printer. The following is a list of
guides available from the Help Menu:

Print Quality e Connection Guide
Color Quality e Supplies Guide
Media Guide * Moving Guide

¢ Print Defects

To print these pages:

1 Onthe operator panel, press Menu
until you see Help Menu.

2 Press Menu until you see the topic
you want to print, and then press
Select.

We strongly recommend that you print
the Jam Clearance guide and keep it
by the printer. These pages are also
available on the publications CD that
shipped with your printer.



Quick Reference sheet

Drivers CD

Lexmark Web site

Introduction
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The printer Quick Reference provides
easy access to information about loading
media, clearing jams, printing
confidential jobs, and understanding
common printer messages.

This information is also available, in a
printable format, on the publications CD
that shipped with your printer.

The drivers CD contains all the
necessary files to get your printer up and
running. It may also contain printer
utilities, screen fonts, and additional
documentation.

Visit our Web site at www.lexmark.com
for updated printer drivers, utilities, and
other printer documentation.



Step 1: Unpack the printer
i

Getting ready for setup

20 cm
(8in.)

58.5cm
(23in.)

25cm

(10in.)

Select a well ventilated location for your
printer that provides room for the trays,
cover, and doors. Choose a firm, level
surface away from direct airflow and
temperature extremes.

Total clearance needed with options

4

Optional 530-sheet tray | Optional duplex unit Both
Height 73.5cm (29 in.) 63.8 cm (25.1in.) 73.5¢cm (29 in.)
Rear 25cm (10in.) 35cm (14 in.) 35cm (14 in.)
Unpack the printer



CAUTION: The printer weighs 30.4 kg (67 Ib), and
requires at least two people to lift it safely.

Operator panel
overlay
(non-English
only)

Power cord

=<
&
Setup Guide with publications CD Photodeveloper
and Quick Reference sheet cartridge

Note: To avoid overexposing the photodeveloper
cartridge, leave it in its packaging until you are ready to
install it.

Unpack the printer
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Remove all items from the box. Make
sure you have the following items:

e Printer with one 250-sheet tray

e Power cord

¢ Photodeveloper cartridge

* Print cartridges (four, shipped
inside printer, wrapped in
packaging)

e Setup Guide with a
publications CD and
Quick Reference sheet

* Drivers CD

e Operator panel overlay
(non-English only)

If any items are missing or damaged,
refer to our Lexmark Web site at
www.lexmark.com for the designated
Lexmark support phone number for your
country.

Remove any tape and packing material
from the printer. Save the carton and
packing material in case you need to
repack the printer.



Step 2: Install printer supplies
i

Installing toner cartridges

Packaging

Install printer supplies
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Follow the instructions in this section to
prepare the toner cartridges.

1 Pull the front door release latch
forward and gently lower the front
door.

2 Remove the packaging.

3 Grasp one of the toner cartridges
by the handle and pull it straight
out.



4 Holdthe cartridge level, and gently
shake it to distribute the toner.

5 Remove the tape and cover from
the cartridge.

Install printer supplies

7



Warning: Do not touch the roller surface under the
cartridge cover. Touching the surface may damage the

roller.

Install printer supplies
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Grasp the cartridge by the handle.

Align the cartridge with the
appropriate slot and slide the
cartridge in.

Toner cartridges must remain in
their original order; they are not
interchangeable in the slots.

Repeat step 3 on page 6 through
step 7 on page 8 to set up the
other cartridges.

Close the front door.



Installing the photodeveloper

cartridge

Warning: The photodeveloper is very delicate. To avoid
damaging it, do not remove its packaging until you are

ready to install it.

Install printer supplies
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Follow the instructions in this section to
install the photodeveloper cartridge.

1 Open the printer top door.

2 Carefully remove the packaging,
pins, and tape from the
photodeveloper cartridge.



Warning: Do not touch the shiny photoconductor film on

the photodeveloper cartridge.
3 Grasp the cartridge by the handle

and align it with its opening. Gently
lower it into place.

4 Push the latches away from each
other to lock the cartridge into
place.

5 Close the top door.

Qoo
0
0

Install printer supplies
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Step 3: Position the optional
drawer

-

CAUTION: If you are adding an optional drawer Your printer supports an optional
sometime after setting up the printer, be sure to turn the 530-sheet drawer. The optional drawer
printer off, unplug the power cord, and disconnect all consists of a support unit and a tray.

cables from the back of the printer before completing
these tasks.

1 Unpack the box. Enclosed are:

* a support unit with the tray
inside
e two side covers (left and right)

¢ two metal brackets (left and
right) with thumbscrews

2 Remove all packing material and
tape from the support unit.

3 Pullthe tray out of the support unit.

Remove any packing material and
tape from the tray.

4 Move the support unit to the
location selected for the printer.

5 Tip the tray slightly and push it fully
into the support unit.

Note: When you add or remove the optional drawer,
remember to update the printer configuration through your
printer driver.

Position the optional drawer
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Step 4: Prepare the printer
i

Positioning the printer

Note: If you have optional memory to install, leave
clearance behind the printer.

CAUTION: The printer weighs 30.4 kg (67 Ib), and
requires at least two people to lift it safely.

Slot

Post

Connector

Prepare the printer
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Once you have selected a location and
positioned an optional drawer (if you have
one), you are ready to position the
printer.

Lift the printer by the recessed handholds
on both sides, and place it on the table or
optional drawer.

To position the printer on an optional
drawer:

1 Align the posts, slots, and
connector on the drawer with the
underside of the printer.

2 Lowerthe printer into place. Make
sure it is seated securely on the
drawer.



Securing the drawer to the printer If you have an optional drawer, secure it

to the printer.

1 Align one bracket with the hole on
the right side of the printer as
shown. Press the bracket flat
against the printer, and then
tighten the thumbscrew.

Tighten
thumbscrew

Bracket

2 Starting at the front of the printer,
push the right side cover onto the
printer, fitting each slot on the

— cover over its corresponding tab
= 0 on the optional drawer, to cover the
gap between the printer and the

.ﬁ\ optional drawer.

Note the side cover orientation.
The side cover is flat on the
bottom.
S -
== sr1 e
S == <
\/
NS )
- 4/

Prepare the printer
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3 Align the other bracket with the
hole on the left side of the printer
Tighten as s_hown. Press the bracket flat
thumbscrew against the printer, and then
tighten the thumbscrew.

Bracket

4 Starting at the front of the printer,
push the left side cover onto the
printer, fitting each slot on the
cover over its corresponding tab
on the optional drawer, to cover the
gap between the printer and the
optional drawer.

Note the side cover orientation.
The side cover is flat on the
bottom.

Prepare the printer

14



Attaching an operator panel overlay

Prepare the printer
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If English is not your preferred language
and your printer shipped with an operator
panel overlay, attach the overlay that has
the appropriately translated button
names:

1 Peelthe protective backing off the
overlay.

2 Align the holes in the overlay with
the lights and buttons on the
operator panel, and then press the
overlay into place. Rub firmly to
transfer the overlay labels.

3 Peel the overlay off the printer.



Adjusting tray 2 margins

Prepare the printer
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Adjusting tray 2 margins ensures your
margins are consistent when tray linking
is enabled.

1
2

Load plain paper in both trays.

From the printer operator panel,
press Menu until you see Setup
Menu, and then press Select.

Press Menu until you see Left
Margin, and then press Select.

Press Menu until you see Tray 2,
and then press Select.

Press Go.
Two pages print.

Follow the instructions on the
printed pages to determine the left
margin value you need.

Repeat steps 1-4, press Menu
until you see the left margin value
you need, and then press Select.



Step 5: Set up the optional
duplex unit

-

Attaching the optional duplex unit Your printer supports an optional duplex

unit which lets you print on both sides of

a page.
CAUTION: If you are installing an optional duplex unit 1 Unpack the duplex unit and
sometime after setting up the printer, turn the printer off discard the packing material.
and unplug the power cord before continuing.
Note: When you add or remove the optional duplex unit, 2 Use a flathead screwdriver to
remember to update the printer configuration through your carefully remove the connector
printer driver. cover, and the upper and lower
duplex covers, from the back of the
printer.

Set up the optional duplex unit

17



3

4

Redrive
assembly

Set up the optional duplex unit
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Insert the bottom of the duplex unit
into the lower opening as shown.

Pull up on the top of the duplex unit
as you swing it up over the top of

the printer, and then press it down
so that it locks fully into the upper
opening.

When the duplex unit is mounted

correctly, there is a small and even
gap between the duplex unit and

the top of the printer, visible from

the front of the printer.

Open the duplex rear door and pull
down the redrive assembly.



6 Pull the two green thumbscrews
out to extend them.

7 Push each green thumbscrew
gently toward the printer as you
turn it clockwise to tighten it fully. If
necessary, use a flathead
screwdriver to tighten the screws.
Then, push the thumbscrews
firmly toward the printer to
collapse them.

Note: Failure to collapse the green thumbscrews can 8 Push up the redrive assembly and
cause jams. close duplex rear door.

Set up the optional duplex unit
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9 Hook the bracket into the slot, and
then turn the mounting screw
clockwise to tighten.

10 Plug in the duplex connector as
shown. The duplex connector
release latch must face away from
the duplex unit.

Set up the optional duplex unit
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Adjusting duplex margins

Adjusting duplex margins ensures your

margins are consistent when two-sided
printing is selected.

Set up the optional duplex unit
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1

2

Load plain paper in the standard
tray.

From the printer operator panel,
press Menu until you see Setup
Menu, and then press Select.

Press Menu until you see Left
Margin, and then press Select.

Press Menu until you see Duplex,
and then press Select.

Press Go.
Two pages print.

Follow the instructions on the
printed pages to determine the left
margin value you need.

Repeat steps 1-4, press Menu
until you see the left margin value
you need, and then press Select.



Step 6: Install memory, firmware,
or option cards

-

CAUTION: If you are installing memory or option cards You can customize your printer memory
sometime after setting up the printer, turn the printer off capacity and connectivity by adding
and unplug the power cord before continuing. optional cards.

The instructions in this section help you
install any of the following:

e Memory cards

— Printer memory
— Flash memory
— Fonts

e Firmware cards

— Bar code
— ImageQuick™
— PrintCryption™

Note: You need a small Phillips screwdriver to remove
the system board access cover.

Install memory, firmware, or option cards
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Removing the system board Follow the instructions in this section to

remove the printer system board.

Warning: Electronic components can be

‘ damaged by rough handling or static electricity.
4.\ | Touch something metal on the printer before
you touch any card.

1 Remove the four screws at the
corners of the system board.

2 Slide the system board straight out
of the printer.

Handles

/,

!

Note: The system board may be tightly seated in the
printer. You may need to pull firmly on the handles.

Install memory, firmware, or option cards
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Installing printer memory Follow the instructions in this section to

install printer memory.

1 Unpack the optional printer
memory card. Avoid touching the
connection points along its edge.
Save the packaging materials.

Memory connector 1

Memory connector 2

2 Open both latches on the
connector completely.

—

EN

Note: Some memory and firmware options offered for
other Lexmark printers cannot be used with your printer.
Refer to the publications CD for specifications.

3 Align the notches on the memory
card with the ridges on the
connector.

Install memory, firmware, or option cards
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4 Push the memory card straight
into the connector until it snaps
into place. Make sure each latch
fits over the notch located on either
side of the memory card.

Installing an optional flash memory Follow the instructions in this section to

or firmware card install flash memory or a firmware card.
The system board has two connection

locations where you can install a total of
one flash memory card and one firmware
card.

Note: Firmware cards offered for other Lexmark printers
cannot be used with your printer.

Warning: Firmware cards are easily damaged by static

electricity. Touch something metal on the printer before

you touch a card.

1 Unpack the flash memory or
firmware card.

Plastic pins
Avoid touching the metal pins on

the bottom of the card. Save the
packaging.

Metal pins

Install memory, firmware, or option cards
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2 Holding the flash memory or
firmware card by its sides, align
the plastic pins on the card with
the holes on the system board.

3 Push in until the flash memory or
firmware card is firmly in place.

Note: The row of metal pins on the firmware card must be
fully inserted along its entire length.

Install memory, firmware, or option cards
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Reinstalling the system board

Follow the instructions below to reinstall
the system board.

1 Orient the system board as shown
and align it with the tracks in the
printer slot.

2 Push the system board firmly and
evenly into the printer. Make sure
the system board is pushed
completely into the printer slot.

3 Reattach the four screws to the
corners of the system board.

Install memory, firmware, or option cards
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Step 7: Load paper
i

Note: If you load any media other than plain letter or A4 Your printer has one standard tray with a

paper, make sure you change the Paper Type and Paper capacity of 250 sheets. If you have

Size settings for that tray. Refer to the publications CD for installed an optional drawer, it can hold

detailed information. an additional 530 sheets, for a total of
780 sheets.

The following table lists the amount and
type of print media each tray accepts.

Capacity

Source (sheets) Paper sizes Envelope sizes Paper types
Tray 1 250 A4, A5, JIS B5, letter, executive, 9, COM 10, DL, | Plain paper, transparencies,

statement C5, B5 labels, card stock, glossy
Tray 1—optional 250 A4, A5, JIS B5, letter, legal, 9, COM 10, DL, | Plain paper, transparencies,
legal tray executive, folio, statement C5,B5 labels, card stock, glossy
Tray 2 530 A4, letter, executive Plain paper

Load paper

28



Loading the trays Follow these instructions to load paper in

the standard and optional trays.

1 Pull the tray completely out.

Note: The length and width guides in an optional 2 If you are loading an optional legal
530-sheet tray are shaped differently than the guides in tray, open the cover.
the standard tray, but the function is the same.

Load paper
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3 Squeeze the tabs at the sides of
the length guide together as
shown. Slide the guide to the
correct position for the size of
paper you are loading, according
to the size indicators on the bottom
front of the tray.

4 Squeeze the tabs at the sides of
the width guide together as shown.
Slide the width guide to the correct
position for the size of paper you
are loading, according to the size
indicators on the bottom left of the
tray.

Notice the load line label on the
side of the tray which indicates the
maximum stack height for your
media.

5 Flex the sheets back and forth to
loosen them, then fan them. Do
not fold or crease the media.
Straighten the edges on a level
surface.

Load paper
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6 Load the stack with the
recommended print side faceup.
Load the stack toward the rear of
the tray as shown.

If you load letterhead paper, place
the header faceup at the rear of
the tray as shown. For two-sided
printing, place the header
facedown at the front of the tray.

Warning: When you load the tray, do not exceed the load
line on the label in the tray. Overfilling the tray may cause
jams.

7 i you are loading an optional legal
tray, close the cover.

8 Re-insert the tray.

Note: Refer to “Loading envelopes in the standard tray“
in the Media specifications chapter of your User’s
Reference for information about loading envelopes.

Load paper
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Step 8: Attach cables
i

CAUTION: Do not connect The printer can be attached to a network or directly to a computer to
or disconnect a print locally.

communication port, a

teleport, or any other

connector during a lightning

storm.

Attachi ng a You can attach your printer locally using either a USB, parallel, or serial
local cable connection.

UsB A USB port is standard on all models.

Windows 98 SE, Windows Me, Windows 2000, and Windows XP
operating systems support USB connections. Some UNIX, Linux, and
Macintosh computers also support USB connections. Refer to your
computer operating system documentation to see if your system
supports USB.

ity

A USB port requires a USB cable such as Lexmark part number
12A2405 (2 m [6.5 ft]).

Be sure to match the USB symbol on the cable to the USB symbol on
the printer.

Attach cables
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Parallel A parallel port is included on base printer models.

A parallel port requires an IEEE-1284 compliant parallel cable such as
Lexmark part number 1329605 (3 m [10 ft]).

Serial A serial port can be attached through the INA port on the printer
system board.

A serial port requires a compatible serial cable such as Lexmark part
number 1038693.

2500,
soooclco

Attach cables
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Attaching a
network cable

Ethernet

Use Category 5 cable with an RJ-45
connector for the standard network
port.

802.11b wireless
options

You can attach your printer to a network using standard network
cables.

A 10BaseT/100BaseTX Fast Ethernet port is standard on the network
model.

To attach the printer to a network:
1 Make sure the printer is turned off and unplugged.

2 Plug one end of the standard network cable into a LAN drop or
hub and the other end into the Ethernet port on the back of the
printer. The printer automatically adjusts for the network speed.

Your printer can be converted to wireless networking by using an
optional 802.11b Wireless Print Adapter. This adapter is a piece of
hardware that plugs into the Ethernet port on your printer.

If you purchased this adapter for your printer, refer to the
documentation that shipped with the adapter for installation and
configuration.

Attach cables
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Tu rning your Follow these instructions to turn your printer on.

prlnter on 1 Plug one end of the printer power cord into the socket at the
back of the printer and the other end into a properly grounded
outlet.

2 Turnonthe printer.

After the printer completes its internal tests, the Ready
message indicates that the printer is ready to receive jobs.

If you see a message other than Ready on the display, refer to
the publications CD for instructions on clearing the message.
Click Printing, and then click Understanding printer
messages.

3 Iif you have attached your printer locally, turn on your computer
and any other peripherals.

What do | do next?

For connection type... Go to...

Local attachment “Install drivers for local printing” on page 36

Network attachment “Verify printer setup” on page 44

Attach cables
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Step 9: Install drivers for local
printing
i

Note: For Windows
operating systems, you can
skip the hardware wizard
and use the drivers CD to
install your printer drivers.
Launch the CD and follow
the instructions to install
printer software.

A local printer is a printer attached to your computer using a USB or
parallel cable. If your printer is attached to a network instead of your
computer, sKip this step and go to Step 10: “Verify printer setup” on
page 44.

A printer driver is software that lets your computer communicate with
your printer. The procedure to install drivers depends on the operating
system you are using.

Select your operating system and cable from the following table to find
driver installation instructions.

Operating system Cable Go to page...
Windows XP; USB’ or Parallel 37

Windows Server 2003

Windows 2000 USB’ or Parallel 38

Windows Me USB’ or Parallel 38

Windows 98 USB’ or Parallel 39

Windows NT 4.x Parallel only 40

Windows 95 Parallel only 40

Macintosh USB only 41
UNIX/Linux USB or Parallel 42

* If you attach a USB printer cable while your printer and computer are
turned on, the Windows hardware wizard launches immediately. Find the

instructions for your operating system and use them to answer the plug and
play screens.

Install drivers for local printing

36




Windows

Before you install

Note: Installing a custom
driver will not replace the
system driver. A separate
printer object will be created
and appear in the Printers
folder.

Using Windows XP or
Windows Server 2003
with USB or

parallel cable

Note: Business versions of
Windows XP require that you
have administrative access
to install printer drivers on
your computer.

In addition to the following driver installation instructions, you may
need to refer to the documentation that shipped with your computer
and your Windows software.

Some versions of Windows software may already have a system
printer driver for this printer included. This may mean that installation
will seem automatic in later versions of Windows. System drivers work
well for simple printing, but they contain less functionality than our
enhanced custom driver.

To obtain all the features of the custom driver, you will need to install
the custom printer driver using the drivers CD that shipped with the
printer.

Drivers are also available in downloadable software packages on our
Lexmark Web site at www.lexmark.com.

When the Found New Hardware Wizard screen appears:

1 Insertthe drivers CD. If the CD auto launches, exit the CD. Click
Next.

2 Browse to the location of the printer driver on the drivers CD:
D:\drivers\win_ 2000\
3 Click Next to install the driver.

If any messages appear regarding the driver not being certified,
it is okay to disregard these messages and click Continue
Anyway. Your printer has been thoroughly tested and is
compatible with Windows XP and Windows Server 2003.

4 Click Finish when the software is installed.

5 Printatest page to verify printer setup.
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Using Windows 2000
with USB or
parallel cable

Note: You need
administrative access to
install printer drivers on your
computer.

Using Windows Me
with USB or
parallel cable

Note: Depending on the
software and printers
already installed on your
computer, your screens may
vary from those in the
instructions.

When the Found New Hardware Wizard screen appears:

1

w

Insert the drivers CD. If the CD auto launches, exit the CD. Click
Next.

Select Search for a suitable driver, and then click Next.
Select only Specify a location, and then click Next.

Browse to the location of the printer driver on the drivers CD:
D:\Drivers\Win_ 2000\

Click Open, and then click OK.

Click Next to install the driver that is displayed.

If a message appears regarding the driver not being digitally
signed, it is okay to disregard this message.

Click Finish when the software is installed.

Print a test page to verify printer setup.

You must install both a USB port driver and an enhanced custom print

driver.

When the Found New Hardware Wizard screen appears:

1

2

Insert the drivers CD. If the CD auto launches, exit the CD. Click
Next.

Select Automatic search for the best driver (recommended),
and then click Next. The wizard searches for a USB port driver.
The name of it will be similar to your printer name.

After the USB port driver is found, click Finish.

Select Automatic search for the best driver (recommended),
and then click Next. The wizard now searches for a printer
driver.

Select your printer and driver from the list, and then click OK.
Make sure you select the driver in the correct language you
want to use.

D:\Drivers\WIN 9X\<LANGUAGE>

6 After the printer driver is installed, click Finish.
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Using Windows 98
with USB or
parallel cable

Note: Depending on the
software and printers
already installed on your
computer, your screens may
vary from those in the
instructions.

Use the default printer name or type a unique name for your
printer, and then click Next.

Click Yes (recommended), and then click Finish to print a test
page.

After the test page prints, click Yes to close the window.

Click Finish to complete the installation and close the wizard.
You are now ready to print.

You must install both a USB port driver and an enhanced custom print

driver.

When the Add New Hardware Wizard screen appears:

1

NOoO oW N

© @

10
11
12

13

14

Insert the drivers CD, and then click Next. If the CD auto
launches, exit the CD.

Select Search for the best driver for your device
(recommended), and then click Next.

Select only CD-ROM drive, and then click Next.
After the wizard finds the USB port driver, click Next.
After the USB port driver is installed, click Finish.
Click Next.

Select Search for the best driver (recommended), and then
click Next.

Select to Specify a location.

Browse to the location of the printer driver on the drivers CD:
D:\Drivers\WIN 9X\english

Click OK.

After the printer driver is found, click Next.

Use the default printer name or type a unique name for your
printer, and then click Next.

Select Yes to print a test page, and then click Finish. All the
necessary files are installed on your computer.

After the test page prints, click Yes to close the message
window.
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Using Windows NT
with a parallel cable

Note: USB support is not
available for Windows NT
operating systems.

Note: You need
administrative access to
install printer drivers on your
computer.

Using Windows 95
with a parallel cable

Note: USB support is not
available for Windows 95
operating systems.

15

Click Finish to complete the installation. You are now ready to
print.

The easiest way to install a driver is to use the drivers CD that shipped
with your printer.

1

O WNDN

~

When

Insert the drivers CD.

Click Install Printer and Software.

Click Printer.

Click Agree to accept the license agreement.
Select Quick Install, and then click Next.

Select the port you want to use, and then select the printer you
are installing.

Click Finish to complete the installation. You are now ready to
print.

the Update Device Driver Wizard screen appears:
Insert the drivers CD. If the CD auto launches, exit the CD.

If a system-compatible driver is found on your operating system,
the Wizard installs it.

If no compatible system driver is found on your operating
system, click Other Locations.

Browse to the location of the printer driver on the drivers CD:
D:\drivers\win_ 9x\english

Click OK.

Click Finish. The Add Printer Wizard screen appears.

Use the default printer name or type a unique name for your
printer, and then click Next.

Click Yes to print a test page.

Click Finish. A test page is sent to the printer once the driver
files are copied to your computer. You are now ready to print.
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Macintosh

Creating a desktop
printer icon
(Macintosh 8.6-9.x)

Note: A PPD file provides
detailed information about
the capabilities of a printer to
your Macintosh computer.

Note: A PPD foryour printer
is also available in a
downloadable software
package on our Lexmark
Web site at
www.lexmark.com.

Macintosh OS 8.6 or later is required for USB printing. To print locally
to a USB-attached printer, you must create a desktop printer icon
(Macintosh 8.6—9.x) or create a queue in Print Center

(Macintosh OS X).

=S

Install a printer PostScript™ Printer Description (PPD) file on
your computer.

a Insert the drivers CD.

b Double-click Classic, and then double-click the installer
package for your printer.

Choose the language you want to use, and then click OK.
Click Accept after you read the license agreement.
Click Continue after you finish with the Readme file.

Choose a default paper size.

Q = 0 Q O

On the Easy Install screen, click Install. All the necessary
files are installed on your computer.

h Click Quit when installation is complete.
Do one of the following:

Macintosh 8.6-9.0. Open Apple LaserWriter.
Macintosh 9.1-9.x. Open Applications, and then click Utilities.

Double-click Desktop Printer Utility.
Select Printer (USB), and then click OK.
In the USB Printer Selection section, click Change.

If your printer does not appear in the USB Printer Selection list,
make sure the USB cable is properly connected and the printer
is turned on.

Select the name of your printer, and then click OK. Your printer
appears in the original Printer (USB) window.

In the PostScript Printer Description (PPD) File section, click
Auto Setup. Make sure your printer PPD now matches your
printer.

Click Create, and then click Save.
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Creating a queue in
Print Center
(Macintosh OS X)

Note: A PPD file provides
detailed information about
the capabilities of a printer to
your Macintosh computer.

Note: A PPD foryour printer
is also available in a
downloadable software
package on our Lexmark
Web site at
www.lexmark.com.

UNIX/Linux

9 Specify a printer name, and then click Save. Your printer is now
saved as a desktop printer.

1 Installa printer PostScript Printer Description (PPD) file on your
computer.

a Insert the drivers CD.

b Double-click Mac OS X, and then double-click the installer
package for your printer.

C Onthe Authorization screen, choose Click the lock to make
changes.

d Enter your password, and then click OK.

€ Click Continue on the Welcome screen and again after you
view the Readme file.

Click Agree to accept the license agreement.
g Select a Destination, and then click Continue.

h On the Easy Install screen, click Install. All the necessary
files are installed on your computer.

I Click Close when installation is complete.

2 Open Finder, click Applications, and then click Utilities.

w

Double-click Print Center.
4 Do one of the following:

If your USB-attached printer appears in the Printer List, you can
quit Print Center. A queue has been created for your printer.

If your USB-attached printer does not appear in the Printer List,
make sure the USB cable is properly connected and the printer
is turned on. After the printer appears in the Printer List, you can
quit Print Center.

Local printing is supported on many UNIX and Linux platforms, such
as Sun Solaris and Red Hat.

The Sun Solaris and Linux packages are available on the drivers CD
and on our Lexmark Web site at www.lexmark.com. The
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User’s Guide in each package gives detailed instructions for installing
and using Lexmark printers in UNIX and Linux environments.

All the printer driver packages support local printing using a parallel
connection. The driver package for Sun Solaris supports USB
connections to Sun Ray appliances and Sun workstations.

Visit our Lexmark Web site at www.lexmark.com for a complete list of
supported UNIX and Linux platforms.

Install drivers for local printing

43



Step 10: Verify printer setup
i

Printing a menu
settings page

Note: For more information
about using the printer
operator panel and changing
menu settings, refer to the
publications CD.

UTILITIES MENU

2

T Menu Select 3 Return

Go5  Stop®

4

The Menu Settings page lists all the options you installed. If a feature
or an option is not listed, check your installation. The Network Setup
page provides information that is needed if you are attaching your
printer to a network.

This is also a good time to print Quick Reference and Clearing Jams
information. See "Printing Quick Reference information” on page 45.

Print a menu settings page to review the default printer settings and to
verify that printer options are installed correctly.
1 Make sure the printer is on.

2 Press Menu until you see UTILITIES MENU, and then press
Select.

3 Press Menu until you see Print Menus, and then press Select
to print the page. The message Printing Menus appears on
the display.

4 Verify that the options you installed are correctly listed under
“Installed Features.”
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Note: When you add or
remove these options:
530-sheet tray, duplex unit,
printer or flash memory, or
firmware card, remember to
update the printer
configuration through your
printer driver.

Printing a network
setup page

Note: If an optional
MarkNet™ print server is
installed, you may see
Print Netl Setup (Or
Print Net2 Setup).

Printing Quick
Reference
information

If an option you installed is not listed, turn the printer off, unplug
the power cord, and reinstall the option. See Step 6: “Install
memory, firmware, or option cards” on page 22 for more
information.

Verify the amount of memory installed is correctly listed under
“Printer Information.”

Verify that the paper trays are configured for the sizes and types
of paper you loaded.

If the printer is attached to a network, print a network setup page to
verify the network connection. This page also provides important
information that helps you configure for network printing.

Save the network setup page after it prints. You will use it in the later

steps.

1
2

Make sure the printer is on.

Press Menu until you see UTILITIES MENU, and then press
Select.

Press Menu until you see Print Net Setup, and then press
Select to print the page.

Check the first section on the network setup page and confirm
that Status is “Connected’”

If Status is “Not Connected,” your LAN drop may not be active
or your network cable may be malfunctioning. Consult your
network administrator for a solution. Afterwards, print another
network setup page to verify connection to your network.

Information about using the printer and clearing jams is included on
the publications CD that shipped with your printer documentation.

We recommend you print this information and store it in a convenient
location near the printer.

To print Quick Reference information stored on the CD:

1
2

Launch the CD.

Click Quick Reference.
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3

Print the document.

To print Quick Reference pages stored in the printer:

1
2

Make sure the printer is on.

Press Menu until you see UTILITIES MENU, and then press
Select.

Press Menu until you see Quick Reference, and then press
Select.

Press Menu until you see the topic you want to print, and then
press Select.

Repeat steps 2 through 4 to print other pages.
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Step 11: Configure for TCP/IP
i

Assigning a printer
IP address

Note: standard Network
appears if you purchased a
printer with a network port on
the printer system board. If
you have a MarkNet print
server installed in option
card slot 1 or 2, you see
Network Option 1 or
Network Option 2.

If you have TCP/IP available on your network, we recommend that you
assign an IP address to the printer.

If your network is using DHCRF, an IP address is automatically assigned
after you connect the network cable to the printer.

1 Look for the address under the “TCP/IP” heading on the
network setup page. This is the page you printed in “Printing a
network setup page” on page 45.

2 Goto “Verifying the IP settings” on page 48 and begin with
step 2.

If your network is not using DHCP, then you must manually assign an
IP address to the printer.

An easy way to do this is to use the printer operator panel:

1 Press Menu until you see NETWORK MENU, and then press
Select.

2 Press Menu until you see Standard Network, and then press
Select.

3 Press Menu until you see Std Net Setup (or Network 1
Setup or Network 2 Setup), and then press Select.

4 Press Menu until you see TCP/IP, and then press Select.

5 Press Menu until you see Set IP Address, and then press
Select.

6 Change the address by pressing Menu to increase or decrease
each number. Press Select to move to the next segment. Press
Select when you are finished.

The message saved appears briefly.

7 Press Menu until you see Set IP Netmask, and then press
Select.
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Verifying the
IP settings

Note: On Windows
computers, click Start »
Run.

Configuring for
Pull Printing

8 Repeat step 6 to set the IP Netmask.

9 Press Menu until you see Set IP Gateway, and then press
Select.

10 Repeat step 6 to set the IP Gateway.

11 When you are finished, press Go to return the printer to the
Ready state.

12 Goonto “Verifying the IP settings” on page 48.

1 Print another network setup page. Look under the “TCP/IP”
heading and make sure the IP address, netmask, and gateway
are what you expected.

See “Printing a network setup page” on page 45 if you need
help.

2 Ping the printer and verify that it responds. For example, at a
command prompt on a network computer, type ping followed
by the new printer IP address (for example, 192.168.0.11):

Ping XXX .XXX.XXX.XXX

If the printer is active on the network, you should receive a reply.

If your printer has an optional ImageQuick firmware card installed, you
can configure for Pull Printing once an IP address has been assigned
to the printer.

For detailed configuration instructions, refer to the CD that shipped
with the ImageQuick firmware card.
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Step 12: Install drivers for

network printing

-

Windows

After you have assigned and verified the TCP/IP settings, you are
ready to install the printer on each network computer.

In Windows environments, network printers can be configured for
direct printing or shared printing. Both network printing methods
require the installation of a printer driver and the creation of a network
printer port.

Supported printer drivers

e  Windows system printer driver
e Lexmark custom printer driver

System drivers are built into Windows operating systems. Custom
drivers are available on the drivers CD.

Updated system and custom drivers are available on our Lexmark
Web site at www.lexmark.com.

Supported network printer ports

e Microsoft IP port—Windows NT 4.0, Windows 2000,
Windows XP, and Windows Server 2003

e Lexmark network port—Windows 95/98/Me, Windows NT 4.0,
Windows 2000, Windows XP, and Windows Server 2003

For basic printer functionality, you can install a system printer driver
and use a system network printer port, such as an LPR or a standard
TCP/IP port. The system printer driver and port let you maintain a
consistent user interface for use with all the printers on your network.
However, using a custom printer driver and network port provides
enhanced functionality, such as printer status alerts. Follow the steps
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for your printing configuration and operating system to configure your
network printer:

Printing configuration Operating system Go to page...
Direct Windows 95/98/Me, 50
¢ Printer is connected directly to the network using a network cable, such w:gggw: lz\lc;rogo

as Ethernet.

* Printer drivers are typically installed on each network computer. Windows XP, or

Windows Server 2003

Shared Windows NT 4.0, 51
Windows 2000,
Windows XP, or
Windows Server 2003

¢ Printer is connected to one of the computers on the network using a local
cable, such as USB.

¢ Printer drivers are installed on the computer attached to the printer.

¢ During driver installation, the printer is set up to be “shared” so that other
network computers can print to it.

Direct printing using To install a custom printer driver and network port:
Wl_ndOWS 95/98,Me, 1 Launch the drivers CD.
Windows NT 4.0,
Windows 2000, 2 Click Install Printer and Software.
Windows XP, and 3 Click Printer.
Windows Server 2003 4 Click Agree to accept the license agreement.
5 Select Quick install, and then click Next.
Printer 6 Click Create new port.
E? 7 Click Add Port.
< > 8 Select Lexmark TCP/IP Network Port, and then click Add.
Clients 9 Enter the information to create the port.
a Assign a logical port name.
This can be any name that you associate with the printer,
such as Colorl-lab4. After the port is created, this name
appears in the list of available ports on the Method of
Connection screen.
Note: If you don’t know the b Enter the IP address in the text box.

IP address, print a network .
setup page and look under € Click Add Port.

the TCP/IP heading. For 10 Click Done until you return to the Method of Connection screen.
help, see “Printing a network

setup page” on page 45.
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Shared printing from a
server using Windows
NT 4.0, Windows 2000,
Windows XP, and
Windows Server 2003

% Printer

v

Clients

11

12
13

Select the newly-created port from the list, and then select the
model of the printer you want to install.

Click Finish to complete the installation.

Print a test page to verify printer installation.

After connecting your printer to a Windows NT 4.0, Windows 2000,
Windows XP, or Windows Server 2003 computer (which will act as a
server), follow these steps to configure your network printer for shared
printing:

Step 1: Install a custom printer driver

1

O g WD

o ~N

Launch the drivers CD.

Click Install Printer and Software.

Click Printer.

Click Agree to accept the license agreement.
Select Quick install, and then click Next.

Select the desired port from the list, and then select the model
of the printer you want to install.

Click Finish to complete the installation.

Print a test page to verify printer installation.

Step 2: Share the printer on the network

1

2
3
4

($)

Click Start » Settings » Printers.
Select the printer you just created.
Click File » Sharing.

Check the Shared check box, and then enter a name in the
Shared Name text box.

In the Alternate Drivers section, select the operating systems of
all the network clients that will print to the printer.

Click OK.
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Note: If you are missing
files, you may be prompted
to provide the server
operating system CD.

Note: This method is
usually the best use of
system resources. The
server handles driver
modifications and the print
job processing. This lets
network clients return to
applications much faster.

7 Check the following to make sure the printer was successfully
shared.

e The printer object in the Printers folder now has a shared
indicator. For example, in Windows NT 4.0, a hand appears
under the printer object.

* Browse Network Neighborhood. Find the host name of the
server and look for the shared name you assigned to the
printer.

Step 3: Install the printer driver (or subset) on network
clients

Using the point and print method

With this method, a subset of driver information is copied from the
server to the client computer. This is just enough information to send
a print job to the printer.

1 On the Windows desktop of the client computer, double-click
Network Neighborhood.

2 Locate the host name of the server computer, and then double-
click the host name.

3 Right-click the shared printer name, and then click Install.

4 wait a few minutes for the driver information to be copied from
the server computer to the client computer, and for a new printer
object to be added to the Printers folder. The time this takes
varies, based on network traffic and other factors.

5 Close Network Neighborhood.

6 Print a test page to verify printer installation.
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Note: If this is a new printer,
you may be prompted to
install a printer driver. If no
system driver is available,
then you will need to provide
a path to available drivers.

Macintosh

Note: A PostScript Printer
Description (PPD) file
provides detailed
information about the
capabilities of a printer to
your UNIX or Macintosh
computers.

Using the peer-to-peer method

With this method, the printer driver is fully installed on each client
computer. Network clients retain control of driver modifications. The
client computer handles the print job processing.

1 Click Start » Settings » Printers.

2 Click Add Printer to launch the Add Printer wizard.
3 Click Network Print Server.
4

Select the network printer from the Shared printers list. If the
printer is not listed, enter the path of the printer in the text box.

The path will look similar to the following:
\\<server host name>\<shared printer name>

The server host name is the name of the server computer that
identifies it to the network. The shared printer name is the name
assigned during the server installation process.

5 Click OK.

6 Select whether you want this printer to be the default printer for
the client, and then click Finish.

7 Print a test page to verify printer installation.

To print to a network printer, each Macintosh user must install a
custom PostScript Printer Description (PPD) file and either create a
desktop printer on the computer (Mac OS 8.6-9.x) or create a print
queue in Print Center (Mac OS X). Follow the instructions for your
operating system:

Operating system Go to page...

Mac OS 8.6 to 9.x 54
Mac OS X version 10.1.2 and later 55
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Mac OS 8.6-9.x

Note: Installing the custom
PPD is required only if this is
the first time the printer has
been set up. If the printer
was previously installed, go
on to “Step 2: Create a

desktop printer” on page 54.

Step 1: Install a custom PPD file

1
2
3
4

5

Insert the drivers CD into your CD-ROM drive.
Double-click Classic.
Double-click the Lexmark Installer icon.

Select the language of your operating system, and then click
OK.

Click Install to install the PPD file for your printer.

Step 2: Create a desktop printer

1
2

In the Chooser, select the LaserWriter 8 driver.

If you have a routed network, select the default zone from the
list. If you don’t know which zone to select, look on the Network
Setup page under AppleTalk for Zone.

Select the new printer from the list.

If you don’t know which printer to select, look on the Network
Setup page under the AppleTalk heading to find the default
name of the printer.

Click Create.

Make sure there is an icon next to the printer name in the
Chooser.

Close the Chooser window.

Verify printer installation.

a Click the desktop printer icon you just created.
b Choose Printing » Change Setup.

* [f the PPD file displayed in the PPD file portion of the
menu is correct for your printer, printer setup is complete.

¢ If the PPD file displayed in the PPD file portion of the
menu is not correct for your printer, repeat “Step 1: Install
a custom PPD file” on page 55.
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Mac OS X version 10.1.2  Step 1: Install a custom PPD file
and later 1 Insert the drivers CD into your CD-ROM drive.
2 Click Mac OS X » English.

3 Double-click the installer icon for your printer to run the installer.

Step 2: Create a print queue in Print Center
1 Click Applications » Utilities » Print Center.
2 Click Add Printer.
3 Choose AppleTalk as your method of connection.
4

If you have a routed network, select the zone from the list. If you
don’t know which zone to select, look on the Network Setup
page under AppleTalk for Zone.

5 Select the new printer from the list, and then click Add.

Note: If you don’t know 6 Verify printer installation:

2’: I;Z%gﬁ;:i gzltics’pjggz a Click Applications » TextEdit.

under the AppleTalk heading b Choose File » Print » Summary. The Summary window

to find the default name of shows the PPD installed for your printer.

the printer.

e |f the PPD file displayed in the Summary window is
correct for your printer, printer setup is complete.

e If the PPD file displayed in the Summary window is not
correct for your printer, delete the print queue from Print
Center and repeat “Step 1: Install a custom PPD file” on
page 55.

UNIX/Linux Your printer supports many UNIX and Linux platforms, such as Sun
Solaris and Red Hat. Visit our Lexmark Web site at
www.lexmark.com for a complete list of supported UNIX and Linux
platforms.

Note: The Sun Solaris and Lexmark provides a printer driver package for each supported UNIX

Linux packages are available and Linux platform. The User’s Guide in each package gives detailed

on the drivers CD and on our instructions for installing and using Lexmark printers in UNIX and

Lexmark Web site at Linux environments.

www.lexmark.com.
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You can download these packages from our Lexmark Web site. You
may also find the driver package you need on the drivers CD.

NetWare Your printer supports both Novell Distributed Print Services (NDPS)
and regular queue-based NetWare environments. For the latest
information about installing a network printer in a NetWare
environment, launch the drivers CD and click View Documentation.
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Step 13: Using the publications
CD
i

Viewing the
CD contents

Note: The publications CD
is shipped inside the
Setup Guide.

Launch the publications CD and browse the contents to see a
complete list of the available information.

The type of helpful information provided on the publications CD
includes:

e Tips for successful printing

e Ways to improve print quality

* Information about using the printer operator panel
e Instructions for replacing supplies

e Solutions to common printing problems

e Methods for clearing jams

e OQOverview of printer menus

e Explanation of printer messages

Using the publications CD
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Distributing the
information

Storing Quick
Reference
information

Congratulations!

You can give users access to the information on the publications CD in
several ways:

e Give the publications CD to a system administrator or the Help
desk.

e Copy the entire contents of the CD (or just specific topics) to a
shared network drive or intranet site.

* Print the information on the publications CD and store it near
the printer for easy access.

e Send Lexmark’s printer documentation URL to printer users
(www.lexmark.com/publications). Users with Internet access
can browse the site.

We recommend that during printer setup you print the Quick
Reference information you want to use. Store the information near the
printer for easy access.

See “Printing Quick Reference information” on page 45 for printing
instructions.

You are now ready to use your new printer. Save this book if you
anticipate purchasing printer options in the future.

Using the publications CD
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